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So you’ve made (or are thinking about) coming over 
to Final Cut Pro?  This session is for those who’ve used 
other video editing packages as well as ‘newbies.’ We’ll 
guide you through major features such as the Editing 
Interface, Color Correction, Audio mixing, and more. 
Even if you’ve been using Final Cut Pro for a while, 
Apple Certified Trainer Richard Harrington will show you 
new efficiencies and hidden secrets.

There’s a lot to editing in Final Cut Pro.  Fortunately 
all of the skills build on one another.  I’ve pulled a few of 
my favorite tips together here for newer users.  These were co-written with Abba Shapiro, a lead 
trainer for Apple.  These come from our new book, Final Cut Pro On the Spot: Timesaving Tips and 
Shortcuts from the Pros, published by CMP Books.

Installation
• Final Cut Pro itself is a fast load
• Final Cut Pro Studio is a LARGE load due to all of the Library Content.  Total of 9 DVD-ROMs.  
Allow 3 hours for full install (RTFM in your ‘spare’ time).
• If installing on multiple machines… copy ass disk images to a hard drive first.
• Repair Permissions before and after install.  Consider using Cocktail.
• Some Optional Install Items on Individual Discs such as additional setups and Templates.

The OS Issue
• Requires OSX 10.3.9
• If going to Tiger, upgrade first
• QuickTime 7.0.x MUST be installed First
• You will lose your QuickTime Pro key… but FCP Serial unlocks QT7
• Get a three-button mouse

Richard M. Harrington
Author’s Bio/Description

A certified instructor for Adobe, Apple, and Avid, Rich is a practiced expert in motion graphic design and digital 
video. His producing skills were also recognized by AV Multimedia Producer Magazine who named him as one of 
the Top Producers of 2004.
Rich is a member of the National Association of Photoshop Professionals Instructor Dream Team, and a popular 
speaker on the digital video circuit. He is also an instructor at the Art Institute of Washington and the American 

University in Washington, D.C.
Rich is an internationally published author. His book, Photoshop CS for Nonlinear Editors, was the first of its kind to focus on 
Photoshop’s application in the world of video. He is also a contributing author for Final Cut Pro On the Spot, After Effects On the Spot, 
Broadcast Graphics on the Spot, After Effects at Work, and The Photoshop World Dream Team Book, Volume 1.
A Masters Degree in Project Management fills out Rich’s broad spectrum of experience.

RHED Pixel – www.rhedpixel.com
Photoshop for Video – www.PhotoshopforVideo.com

With RICHARD M. HARRINGTON

Final Cut Pro Workshop



notes
�

With RICHARD M. HARRINGTON

Final Cut Pro Workshop

Highlights of New Content

LiveType Soundtrack Pro Motion DVD Studio Pro

• 40 New Templates
• 71 New Objects
• 15 New Fonts
• 20 New Effects

• 5000 Loops
• Many More Sound 
Effects
• Several Powerful 
Audio Unit Plug-ins.
• New HD Templates

• Core Video Filters 
and Generators
• More Particles
• 16 and 32 bit sup-
port

• New HD Templates
• More Templates
• AC3 integrated into 
Compressor

System Requirements/Recommendations
PROGRAM PROCESSORS RAM RECOMMENDED

FCP 500 MHz G4 512 MB 2 GB

FCP HD 1 GHz G4 1 GB 2 GB

Soundtrack Pro	 450 Dual, 500 Single 512 MB 733 MHz

Motion	 867 MHz 512 MB 2 GHz & 2 GB

DVD	 733 MHz	  512 – 8mb VRAM

DVD HD G5
OS 10.4
DVD 4.6

512 – 8mb VRAM

Editing Formats
Final Cut Pro 5 Adds Increased Support for the following formats.

HDV (Sony, Canon, Sharp, JVC)
o  25 Mbps (Same data rate and storage requirements as DV)
o  Uses MPEG-2 Compression
o  Dynamic decompression cuts into system performance.  If disk space and speed is not an 

issue, use Apple Intermediate codec, which adds I Frames for every frame.
o  Uses a different logging window, which is re-sizeable.

Format Frame Size Data Rate

DV NTSC 720 X 480 3.6 MB/sec or 12 GB/hr

DV PAL 720 X 576 3.6 MB/sec or 12 GB/hr

MPEG-2 HDV 720p30 1280 X 720 2.5 MB/sec or 9 GB/hr

MPEG-2 HDV 1080i60/50 1440 X 1080 3.3 MB/sec or 12 GB/hr

Apple Intermediate Codec HDV 720p30 1280 X 720 7 MB/sec or 25 GB/hr

Apple Intermediate Codec HDV 1080i50 1440 X 1080 12 MB/sec or 42 GB/hr

Apple Intermediate Codec HDV 1080i60 1440 X 1080 14 MB/sec or 49 GB/hr
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DVCPRO 50 & HD  (Panasonic)
o More support and RT performance
o DVCPRO HD (100 Mbps)
o Support for P2 cards for the soon to be released AG-DHX cameras.

HDV 1080i50 1440X1080

HDV 1080i60 1440X1080

720p30 1280X720

DVCPROHD 1080i 1920X1080

DVCPROHD 720p 1280X720

G5 RAM Hand in Hand
So you’ve made the plunge and bought a new G5.  They’re pretty cool machines (and noisy at 

times) thanks to all those fans.  They also have a maximum RAM capacity of 8 GB…  that RAM can 
really come in handy if you have a lot of applications open or are using Real-Time or audio filters.

But remember… when you are buying that RAM, you have to install it in pairs (like the old 
days).  Be sure that the RAM matches, both in size, speed, and manufacturer.  Also, follow instruc-
tions on installation and always use a grounding strap.

Dynamic Interfaces
One of the coolest features of Final Cut Pro is 

the dynamic resizing of the interface.  You can now 
quickly adjust the size of windows using dynamic 
resizing.  Clicking between two windows or at the 
intersection of multiple windows allows you to drag 
and resize all windows.  You no longer have to resize 
one window at a time.

Need more space in the timeline, just grab the 
top edge and pull upward.  Want to see more in the viewer, grab the edge and pull to the right.  
It’s simple to quickly change the size of a window and view exactly what you need.

Get it Right from the Start
If you working with multiple formats and resolu-

tions this is a critical preferences.  It is very easy to 
create a new sequence and have it set up improp-
erly for the media you are working on.  Check the 
Prompt for settings on New Sequence checkbox 
and Final Cut Pro will ask you to set your sequence 
settings each time you create a new sequence.

Psychic Powers
Want to quickly learn the name and shortcuts for your tools?  

That’s what tool tips are for.  Just hover over an unknown but-
ton and you will often find out its name and keyboard shortcut.  
If this isn’t working, be sure to check that the Show Tool Tips 
box is checked in the general preferences panel.
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That’s the spot!
You’ve perfectly configured your windows.  Every palette is exactly where you want it.  The 

timeline has just enough room and you’ve got the audio meter exactly where it should be.  Now 
save that window arrangement.

Long-term storage
1: Choose Window>Arrange> Save Layout.  This setting is stored by default in your Window 
Layouts folder. 
2: Starting with FCP4, custom layouts are added to the bottom of the list with a new keyboard 
shortcut automatically assigned.
3: Now call up your Button List (Tools>Button List) or Option + J and type the word window.  
Grab the Window Layout button and drag it to a convenient button well.
*** Note that the Custom layout is an alphabetized list.  Number your layouts when saving them. 
Example 1. Effects, 2. Compositing, and so on.)

Short-term storage
Still testing the layout to make sure 

you like it?  You can save it temporarily 
in one of two custom positions.
1: Hold down the Option key and 
Choose Window>Arrange> Set Custom 
Layout.
2: The setting is stored into 1 of 2 tem-
porary spots. 

Stealing Effects
Thanks to Final Cut Pro’s improved media management, you can now 

steal rendered effects from one sequence and place them in another.  
Perhaps you have a clip that has had several image effects applied to it, 
you can copy this to your clipboard and paste it into another sequence.  
As long as you do not composite anything on top of it, your render files 
should stick.  Any transitions will just need the overlapping handles ren-
dered.

Seeing Red
If you are getting red bars across all your 

footage as soon as you add to the timeline, 
you are probably not configured correctly.  
It is likely that the last project worked on 
used a different configuration (such as 
Widescreen or Offline RT).  Check your 
sequence settings (Command + 0).

Final Cut Pro Workshop
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How to Kill a Hard Drive
The best way to kill a drive is to fill it up so much 
that it essentially locks up.  Final Cut Pro seems 
to have a death wish when it comes to hard 
drives.  Call up your system settings and check the 
Minimum Allowable Free Space on Scratch Disks 
field.
You’ll notice that the default setting is that your scratch discs will fill up to within 10mb before 
being seen as full.  This is like driving in the desert with less than a 1/4-gallon of gas.  Be sure to 
change this number to 500 MB or 5% of a drive’s capacity, whichever number is bigger.

Precision Preview
Wouldn’t it be nice to preview your complex 

effects without actually rendering to disk?  It’s a 
pain getting your hard drive all cluttered with extra 
render files that eat up drive space.  Well you have a 
solution, render to RAM.

The QuickView is a great way to view your 
sequence outside of the Canvas window.  It caches 
frames into RAM as you play it.
• The QuickView has creates no render files, which is 
good for media management.
• If you preview an effect and like it, you will still 
have to render before you can do finally output.  
QuickView is for previewing only.

• You can choose Full, Half, or Quarter as your viewing resolution.  Lower quality will speed up pre-
views, but may impact certain effects that contain mattes or fine edges.
• Be sure you have specified which video to cache:
o Auto: chooses the Viewer or the Canvas, whichever is active.
o Viewer or Canvas: Caches from selected window.
o None: Disables preview (we know… silly choice).

That music is HOT…too hot!
We talked about mixing to –12 db when you edit to DV (-18 or –20 db for digibeta)…but peo-

ple often forget that music that they convert and insert off music CDs is mixed to –0db.  (Yes we 
meant to say the – before the zero.  That’s because music CD’s are mixed and compressed so they 
sound nice and loud in your car and on your iPod; they peak right below Zero db.)

Remember when ever you use music from a CD, to pull its levels down so they hit the appropri-
ate (–12 or –20db) target levels of your show.

Final Cut Pro Workshop
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Place your hands ‘here’
When editing on a desktop system, it’s 

important to think ergonomically.  Proper hand 
position improves your speed and cuts down 
on work-related pain.  When editing, try placing 
your hands in the following position.

Step 1: Place the mouse in your preferred 
hand
Step 2: Offset the keyboard so they J-K-L keys 
fall directly under your opposite hand.

Why?  Well 90% of the edit commands can be 
accessed from this position.

J – Play Reverse.  Tap J to go faster.
K – Pause.  Hold K down while using J or L to play in slow- motion.
L – Play Forward. Tap L to go faster.
I – In
O – Out
F9 – Insert
F10 – Overwrite

Add the Shift, Option, and Command keys for several additional options that speed up editing. 
In fact, the neighboring keys all hold key commands by default; this is definitely ‘prime real estate’ 
in the editing world.

Got snaps?
Sometimes you want things to quickly jump into their proper place.  Final Cut Pro referrers to 

this as snapping.  When turned on, items will ‘snap’ directly to the playhead, an edit point, Markers, 
Keyframes, or In and Out points.  This makes it easier to align clips (especially when keying graph-
ics on a higher track).

 	 Look for a small gray 
arrow that appears above or below 
the point which indicates the item 
has snapped into place.  But what 
if snapping is getting in the way of 
your edit or composite?  Turn it off!

	 You can turn snapping on 
or off at any time, even as you’re 
dragging a clip.  Simply press the 
N key to disable snapping.  You’ll 
notice the snapping icon change on the right edge of the timeline.

	 Snapping affects several areas besides the timeline.  You may want to turn it of when 
scrubbing, trimming, or using motion controls.  Even the Viewer and the Canvas can be affected.

Final Cut Pro Workshop
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DO NOT DRAG   
AND DROP. 

 Professional editors edit from 
the keyboard.  Don’t believe us?  
Ever see a concert pianist use a 
mouse?

Let it Roll
Too many tracks in your timeline and want to scroll up and 

down quickly?  No need to grab the scroll bar on the right 
edge if you have a three-button mouse.  Put the cursor over 
the timeline and use the third button to scroll up and down.  
It gets better, hold down the shift key and you can scroll left 
and right. Don’t stop now, place the cursor over the viewer or 
canvas and you can scrub backwards and forward.  If you aren’t 
impressed yet by Apple’s thoughtful engineers… go try these 
shortcuts in a bin and on effect sliders.

Fly!
It is possible to trim on the 

fly.  This way you can listen for 
an audio edit or look for a par-
ticular visual cue.  
1: Enter trim mode and press 
the space bar to cycle your trim.
2: When you reach the desired 
edit point, press the I key to 
move your in-point.
3: Press the up or down arrow 
to move through the timeline to your next edit point.

Power Log
Did you realize you can log faster than real time?  

Try these 3 tips to get your footage in fast.

1: Simply tap the L button multiple times to play 
the tape faster. With practice you can ramp your 
playback speed up and still understand the dialog.  
All of your logging controls still work.  
2: Better yet, log while viewing.  Tap I to mark an 
In point, then press F2 to simultaneously add the 
Outpoint and Log the Clip.
3: Uncheck the prompt box in the logging win-
dow.  After you name the first clip, all subsequent 
clips will be progressively numbered or lettered.  

Final Cut Pro Workshop
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Like a guy asking for directions
Have you ever needed to go on a road-trip across 

state lines or to a location out of town?  Some 
people forget the first rule of video (PLAN) and just 
jump in the car and try to go instantly.  This option 
is prone to many issues.

Several editors I meet do not harness the power 
of Batch Capture.  They rely on the very inefficient 
Capture Clip, or worse, the potentially dangerous 
Capture Now. So what’s the big deal you say… the 
video goes into the computer.

Getting into capture mode takes time.  You will 
see increased stability and efficiency if you do all of 
your capturing at once.  Plus a batch capture let’s 
you put the computer to work while you change 
gears.  Let the computer spend 30 minutes captur-
ing on it’s own and you can work on picking music, switch to a second machine and work on 
graphics in LiveType or Photoshop, or even just return voice & e-mail.  
 
Step 1: Define which bin is your logging bin.  This is where clips will be stored.  It is a good idea 
to have a separate bin per source tape.  This makes it easier to batch capture and archive.
Step 2: Review and Log your footage.  Mark In and Out points like always.  When a clip is 
defined Click the Log Clip button or press F2.
Step 3: Before a batch capture, SAVE your project.  Bringing video in is one of the most demand-
ing tasks on the application.  You are most likely to crash during capture.
Step 4: When ready, click Batch Capture or press Control + C. You can only batch capture if your 
camera or deck supports device control.  Most firewire devices and professional video decks are 
supported.  You may need to get a special deck control cable and USB to serial adapter to use 
older professional decks.
Step 5: The best part of batch capture is that it is an automated process.  You can leave your 
system unattended while it captures the logged clips.   So your system will not hiccup, you will 
need to change a few preferences.  Under the General Settings tab be sure to uncheck the Abort 
capture on dropped frames and Abort capture on timecode break boxes.

Power Log
Did you realize you can log faster than real-time? 
Try these three tips to get your footage in fast:
• Simply tap the L button multiple times to play the 
tape faster. With practice you can ramp your play-
back speed up and still understand the dialogue. 
All of your logging controls still work. 
• Better yet, log while viewing. Tap I to mark an In 
point, and then press F2 to simultaneously add the 
outpoint and log the clip.
• Uncheck the prompt box in the logging window. 
After you name the first clip, all subsequent clips 
will be progressively numbered or lettered. 

Final Cut Pro Workshop
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Slowly Trim the Dynamic Trim
But what if you want to roll the edit point more 
slowly? This tip will come in handy when trying to 
trim around syllables:

1: Select the edit point with the roll edit tool or 
select tool, and double-click.

2: Hold down the K key and use J or L to roll the edit point left or right at quarter speed.
3: When you find the edit point, release the K key first to establish the 
new edit point.

What You Want
The auto-select buttons help let you work with only on the 

tracks you want. Say you want to delete video from tracks 1, 2, and 
5 but leave tracks 3 and 4 alone. Simply auto-select tracks 1, 2, and 
5, mark and In and an Out point in the Timeline, and delete. They’re 
gone, and tracks 3 and 4 are untouched. Ripple delete works, too...
but be careful, you may throw your Timeline out of sync.

Copy + Paste = Change
It seems that Copying and Pasting clips in the Timeline is a bit of a moving target.  We person-

ally think it’s a change for the better.  Here’s the new rule, if you copy something to your clipboard, 
it will paste into the same track, unless you change its target.

Step 1:  Select your clip(s) in the Timeline
Step 2:  Press Cmd+C to copy the clip(s).
Step 3:  Press Cmd+V to paste the clip(s) into the same track.

In order to copy and paste clips from one track in the Timeline to another, you use the Option key.

Step 1:  Select your clip(s) in the Timeline
Step 2:  Press Cmd+C to copy the clip(s).
Step 3:  Option-click the lowest numbered 
Auto Select control to select the track you want 
to begin pasting into.  If multiple tracks are 
selected they will paste to a higher track.
Step 4:  Press Cmd+V to paste the clip(s).
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Web site Info: www.rhedpixel.com, www.photoshopforvideo.com 
Contact Info: RHED Pixel for production services, Creative Cow for technical questions.
For more - check out Final Cut Pro On the Spot

Widescreen to VHS
	 This tip should have been in 

the first edition (thanks to Rick Finley for 
pointing it out to us).  What happens if 
you have a widescreen video that you 
need to give to your client on VHS?  Sure 
DVD players have a widescreen option, 
but VCRs don’t.
1: Create a new standard aspect ration 
sequence
2: Drag your widescreen sequence into 
the Timeline as if it were a clip
3: Select the edited clip (which is really 
a sequence) and press Return or Enter to 
load it into the Viewer.
4: In the motion tab, set the aspect ratio to -33 to compensate for the widescreen shape.
5: Render then output.
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